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Zassy "/

_@ Amateur Radio Software.

» N3FJP develops and sells a suite of logging programs

» Each program is for a different contest/event
» The programs all have the same look and feel
= Learn to use one and you can use them all

» This is an introduction to using this logger

» Our web site has another presentation on logging here  Richjoerger

WB4EHG
2022/01/27


http://www.dcarc.club/presentations/2020-09-01%20Introduction%20to%20Logging%20V1.0.pdf

Introduction

» This presentation shows you the parts of the Winter Field
Day logger and how to use them

» This information refers to all of the N3FJP loggers

» It also has information about how networking on our
aptops is set up for sharing the logger file across the
aptops.
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Logger’'s Main Form

» The logger main form is where all the action takes place.

> This Is where enter the information from the other station
and you log the contact
» The It has several sections.

= \We will examine each section

» The file has information on other logger sections

» The file has information on how the logger is networked
across the club’s laptops

Rich Joerger
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The Main Form

w7 N3FJP's Winter Field Day Contest Log 2.8.1.1 www.nEfjp.mm)

File  Settings Band Mode View Network Operator Help

B Current Band & Mode Recent Contacts as Score Statistics

R Date / T Bnd Mode  Count initials  Operat
ec ate / Time nd Mode | Country NS o PRI Total CW Contacts

Total Phone Contacts
Total DIG Contacts
Total Multipliers

Total Score

QSOs / Hr (Last 20 min)
QSO0s / Hr (Last 60 min)

5

AR NTX co MO
LA OK 1A ND
MS STX KS NE
NM WTX MN sD

Canada

6 | e nr

EB BC

Spot Last

Possible Duplicates Any Portion
North New Jersey Total =0 LAX

PE
Qc
SK

. “ : -“- 10.13600 NA4DC m 5:28:32
sand tode 17:28:32 UTC




Main Form: Set the Operator

» When you start operating we want you to set the
operator fields to your callsign and initials

» You do this by using the Operator menu item

%7 N3FJP's Winter Field Day Contest Log 2.8.1.1

B Current Band & Mode Recen

Rec Call Cat Sec Date / Time

-
Operator

Operator WB4EHG
Initials RBJ

Rich Joerger
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Main Form: Contact Table

w7 N3FIP's Winter Field Day Contest Log 2.8.1.1

File Settings Band Mode View Network Operator Help

B Current Band & Mode Recent Contacts © Last20 @ Al

Call Date / Time Bnd Initials Operator
N4QV 01/26 18:11 30 RBJ WBA4E..
WB2RUU 01/26 18:11 30 RBJ  WBA4E..
WB3ANE 01/26 18:00 30 RBJ  WBA4E..
W4PPX 01/26 18:00 30 RBJ  WBA4E..
WB4EHG 01/26 18:00 30 RBJ WBA4E..
KK4GUX 01/26 17:52 30 RBJ  WBA4E..
VA3ISP 01/26 17:50 30 RBJ WBA4E..
K40XM 01/26 17:41 30 RBJ  WBA4E..
KJ3Q 01/26 17:41 30 RBJ WBA4E..
WB4BAG 01/26 17:39 30 RBJ  WBA4E..

VAFA AVAT [ e O T~ W e I | 2N DD | WD AT

W0 —
o =

8
7
6
e
4
3
2
4

This is the table of contacts that have been made by ALL of our
stations.

All of our stations write their contacts into a common database
stored on Laptop #2, this is why you must not turn off Laptop #2.
With in a minute of making a contact, all the laptops will be updated Rich Joerger

so don't be surprised when a contact you didn't make shows up WB4EHG
2022/01/27




Main Form: Set Your Band & Mode

w7/ N3FIP's Winter Field Day Contest Log 2.8.1.1 www.n3fjp.com I

File Seftings Band Mode View Network Operator Help

M Current Band & Mode Recent Contacts © Last20 @ Al Score Statistics

R Call Date / Ti Bnd Mod Count Initial Operat
ec a ate ime n ode ountry nitials perator Total CW Contacts

Total Phone Contacts

» Make sure that when you change the band or mode Total DIG Contacts
Total Multipliers

that the logger recognizes the change Total Score
QSOs / Hr (Last 20 min)
QSOs / Hr (Last 60 min)

___Call [ Cat [ Section | __ox g 3 B 5
|

DX DE MDC AR NTX co MO
7 ] e o S
MS STX KS NE

cT RI “ NM WTX MN sD

Vas
AL sc Canada

HE “
~A esl
AB NT

BC

Except for the station running RTTY/PSK, the logger If they are not set
properly you can

gets your band and mode from the radio. , _
When you change bands or modes, verify that these click the box and it PE
values get set properly will allow you to set " ac

the values n oK

Bearing: T
- : 30 B PH | 10.13600 NA4DC | 30 [ SFL 2:28.32
Miles: Band _ Mode - 17:28:32 UTC




Main Form: Your Sent Echan

«; MN3FJP's Winter Field Day Centest Log 2.8.1.1

File  Settings Band Mode View Network Operator Help

W Current Band & Mode Recent Contacts © Last20 @ Al Score Statistics
Ri Date / Ti Bnd Mod Count Initial 0 f
ec ate / Time nd Mode  Country il LR RI] Total CW Contacts

Total Phone Contacts

Total DIG Contacts

NA4DC is pronounced 30 is pronounced SFL is pronounced
November Alpha Four Delta Three Oscar Sierra Foxtrot Lima il
olal =core

Charlie
QSOs / Hr (Last 20 min)
\ \ QSOs / Hr (Last 60 min)

Total Multipliers

\

\
| AK NV co MO
AZ OR 1A ND

uT KS NE
ID WWA MN sD

wy

Possible Duplicates Any Portion =2 il e
\l AY [ nlr

Canada

Spot Last

(a1

North New Jersey Total=0

This is what yQu send to
ther station

: 30 : “ 10.13600 m 5:28:32
sand Hode 172832 UTC




%7 N3FJP's Winter Field Day Contest Log 2.8.1.1

File Seftings Band Mode View Network Operator Help

B Current Band & Mode Recent Contacts

Date / Time Bnd Mode Country

@ Last 20

Initials Operator

Score Statistics

Total CW Contacts
Total Phone Contacts
Total DIG Contacts
Total Multipliers

Total Score

QSOs / Hr (Last 20 min)
QSOs / Hr (Last 60 min)

DX

CcT RI
VT

Spot Last NH

Possible Duplicates Any Portion “

North New Jersey Total=0

AR
LA
MS
NM

5 a7

0
o
=
o

NTX AK NV
OK AZ OR
STX uT
WTX ID WWA
AT e

w = =
O m O

Timel
Our logs are kept in UTC (Universal
Coordinated Time, aka Zulu & GMT)
Time uses the 24 hour format.

The laptop and logger take care of this for you

Band: woce: [T

___NAsDC___ i 30 J§ SFL_ ot UTC




Main Form: ctions rke

%/ N3FJP’s Winter Field Day Contest Log 2.8.1.1 www.n3fjp.com

File Settings Band Mode View MNetwork Operator Help Th|S iS the Section table

W Current Band & Mode
fis Date | Tume Notice that it lists all US and CDN ARRL/RAC sections.

It does NOT list sections for US possessions such as Puerto Rico, Guan, US
\Virgin Islands, ...

All DX (foreign contacts) are lumped into one section.

This is because the goal is to work all US & CDN sections.

Spot Last

Possible Duplicates Any Portion
North New Jersey Total=0

PE
Qc
SK

. 30 : “ 10.13600 NA4DC m 5:28:32
=and tode 17:28:32 UTC




Main Form: Our Goal

Make all the red sections turn blue

Goal: work all US and
Canadian sections & stations

Each new section is a

[ 8 ] multiplier.
DX DE AR Our score is calculated

o LA OK multiplying our number

MS

“ of contacts times the
CT RI MM

VT number of multipliers.
AL sSC

ME
GA 6
NH

Ky ™ New sections are

R | v = 'mportant

Vi LAX
PR

Rich Joerger
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Main Form: Working a New Section

The contact entry section shows you New is shown here
how the logger indicates that you have | Cat because itis a
1H

worked a new section KK4GUX DE| multiplier

When you work a
new section the
section’s color
changes in the
table

Rich Joerger
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Making a Contact

» There are two types of contest operating:

= Running a frequency

Find a clear frequency and start calling Je{@REE RN .C1p10%
This Is the fastest way to make contacts. They chase you.

= Search and Pounce (S&P)

Start at one end of the band, spin the VFO and work every
station you can

You call the other station: “|glERe=N Il RN VID]®

This Is a slow way to make contacts

Rich Joerger
WB4EHG
2022/01/27



Making a Contact

» You can use the method you are comfortable with

* |n both cases you MUST enter his contact
Information and hit the return key to log the contact

Note: you use the Tab key to move from one entry box to the next

= Before working a station you must enter his call sign to
ensure you have not worked him already

If you are operating S&P you should enter all his

iInformation before working him but don't hit enter until

Rich Joerger
WB4EHG
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Making a Contact

» You must enter 3 things from the other station

This is the logger’s
= His (@]l Sign Cat Sect -« | I contact entry

section

KK4GUX 1H DE|

= His [@Ellegory/Class

Category/Class are a number followed by a letter.
Number = how many transmitters they have on the air

» His ARRL/RAC Letter is one of: “I” (India), “O” (Oscar), “H” (Hotel)

» The program will not let you enter a bad category or
section, it will warn you & refuse to accept the entry

But you can enter a wrong category or section

Rich Joerger
WB4EHG
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Main Form: Entering His Info

w7 N3FJP's Winter Field Day Contest Log 2.8.1.1 www.n3fjp.com]

File  Settings Band Mode MNetwork  Operator Help
e i Recent Contacts y—r——

Rec Call Cat Date / Time Bnd Mode Count Initials Operatar
4 P Total CW Contacts

When you enter his Total Phone Contacts
call and tab to the Total DIG Contacts
next box, the software

Listen to the other will warn you if he is a

- i ) station before calling dup - you have
This is the information from the other | |and enter this info already worked him QSOs / Hr (Last 20 min)

station that you enter here BEFORE calling him on this band QSOs / Hr (Last 60 min)

Total Multipliers

Total Score

__Call N Cat [ Section
|

Spot Last

Possible Duplicates Any Portion
North New Jersey Total =0

ENY . NNY
NLI - SNJ
NNJ  © WNY

: 30 . “ 10.13600 5:28:32
sand Mode 172832 UTC




Main Form: Entering Bad Info
Section

VA3ISP

> The correct 3 5 | 0
DX DE MDC AR NTX AK NV MO

SeCtiOnS are in I EPA WPA LA oK AZ OR ND

Mms STX uT NE

this table cT RI [ 4 [, ID WWA MN sD

GA 6 ;g 8
NH AB NT

KY TN

LAX OMNN

BC ONE
Vi
ONS
PE
Qc
SK

PR




Main Form: Entering His Info

» The logger will give you some help getting his
iInformation.

= |f we have worked him before on another band or
mode, the logger will fill in his category and section

= |f he Is a contester his call might be in a datafile
called “Super Check Partial” which the logger will

search for you

Rich Joerger
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Super Check Partial i

» The logger starts searching the database when you start
entering a call sign.

» It displays call signs from the database that match the
part of the call already entered.

» As you enter more characters the match gets better and
better

» Call search results are shown on the main form as you enter the

Cal | SI g n Rich Joerger

WB4EHG
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http://www.supercheckpartial.com/

Main Form: Super Check Partial

[ cal [ cat [ Section | [ cal [ Cat [N Section |
>} W4

Pos Dupes / Partials Any Portion Pos Dupes / Partials Any Portion
UEIEIYE 4u1wWB 9A2WB AA3WB ADOWB AD5SWB BH2SWB - ||[T[=ZLYe] WB4AAA WB4ABY WB4AEG WB4C WB4CUZ
DF5WBA DF9WB DK1WB DL1SWB DL2HWB DM2WB _ ||lwB4CW WB4DC WB4DKQ WB4DKU WB4DNL WBA4E
DO3WBH DU1WBX EA2EWB FAWBL FS4WBS GOBWB WB4EEH WB4EHG WB4EWS WB4FDT WB4FSF WB4FSU
G3WBB I0WBX IK2WBK IK3SWB IT9RWB JATKWB JATWBX WB4FWQ WB4GHZ WB4HMA WB4HRL WB4IIH WB4IT
JAJUWB JA6BWB JATOWB JETWBI JI2IWB KOTWB K1WB WB4JFS WB4JHS WB4KDI WB4KFO WB4KLI WB4KTF
K2WB K4WB K4WBG K7AWB KOWBS KB5WB KC5HWB WB4KUU WB4MDX WB4MJF WB4MM WB4MNK WB4MSG

| cal [ Cat [N Section | Cal [ Cat [ Section

> WB4E| WBA4EH

Super Check Partials Any Portion Super Check Partials Any Portion
WB4E WB4EEH WB4EHG WB4EWS WBJ4EHG
. Rich Joerger
Call 1is complete WB4EHG

2022/01/27



Main Form: Dups

» Serious contesters get pretty annoyed when you try to
work them a 2" time on the same band with the same
mode. You have wasted their time.

» And you waste your time

» That's why we network the computers

» Before working a station you must enter his call

» The logger will alert you if there Is a pOSSIb|e match on
the same band and mode already Rl

Rich Joerger
_ WB4EHG
g waw T . - 2022/01/27




Main Form: Dups

» The possible dup
warning looks like this

W1AW

Spot Last

Pos Dupes / Partials Any Portion
WErAL'E W1AW

» Press the ESC key and move on to another

contact

» The dup warning looks like this

which i1s shown if you tab from
the Call box

Cat
W1AW

Press ESC to clear
this warning

Spot Last |

Any Portion

Pos Dupes / Partials
W1AW RV

Rich Joerger
WB4EHG
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Main Form: Editing a Log Entry

» Mistakes happen, we all make them.
» The logger allows you to edit a logged contact

I entered the wrong section

Call C ) Date [/ Time BEnd Mode
WB3ANE 01/26 18:00 30 PH

Click the entry in the table and 2 boxs appear

9 | WB3ANE __ 01/26 18:00

WAPPX s5C 01/26 18:00
WB4EHG 1H RI 01/26 18:00
KKAGIX 1H nE N1i26_17-62

KACHKM 20

Edit the necessary boxs and click the Done button or cancel to quit

- L .

2022/01/26 18:00:50 30 RBJ

dit Contact

Rich Joerger

WB4EHG
| 2022/01/27




Main Form: Our Score
N3F)¥s Winter Field Day Contest Log 2.8.1.1 wnw.n3fjp.com
File Settings Band Mode View MNetwork Operator Help

This is our cumulative score. Total CW Contacts
The info will change after every contact.
The logger calculates this for us.

The opertor cannot change these values,
except for making contacts. Total Multipliers

Total Phone Contacts
Total DIG Contacts

Total Score

QSOs / Hr (Last 20 min)

QSOs / Hr (Last 60 min)

AR NTX NV
LA OK OR
MS STX uTt
NM WTX WWA

= = y

= x5 0
= v > 0
w =z =

S md 3

Rich Joerger
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Main Form: Spotting

» Spotting refers to when a station makes a contact and then enters the
contact information (call, band/frequency, mode) into an on-line
database.

» Other hams watch the database via a web browser and will try to work
that station.

» The logger can display spots and filter them to the band and mode you
are operating.

» Enabling spotting requires very careful configuration otherwise an

operator can click on a spot that takes them to a band they are not set up
to operate, possibly harming the transmitter or the band pass filter.

For that reason, | am leaving spotting turned off in N3FJP. The advanced

operator can turn it on.

Rich Joerger
WB4EHG
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Spotting

» You can use spotting web sites on-line

> Here are a few | use Lanoe
. Jan-26
Jan-26

- Jan-26
Jan-26

- Jan-26
Jan-26

» You can see where your signal is being t:jif
heard Jan-26

» You can check on propagation

Jan-26 23:

Jan-26 23

2319
2317
2317
2317
2316
2316
2316
2314
2314

2313 ¢

Freq Sig Mode Grid St
7078.71 -05 JTBS5A
7186.00 SSB
7007.30 cw
7156.00 SSB
7120.00 SSB
7156.00 SSB
7056.80 +23 RTTY
7135.00 SSB
7032.00

7180.00 SSB
7178.00 SSB
7156.00 SSB

Country
Azerbaijan
Puerto Rico
England
Cayman Islands
Belize
Cayman Islands
France
Venezuela

Spain

Puerto Rico
European Russia
Cayman Islands

Spotter
KM3T
VE3XIN
G1TLH
YO3IPR
[Z8DPJ
YO3IPR
WZTI
VE3XIN
NS4V
EC1DJ
PWSBR
NARWG

Rich Joerger
WB4EHG
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https://dxwatch.com/
https://hamspots.net/
http://dxsummit.fi/#/
https://pskreporter.info/pskmap.html
https://www.dxmaps.com/spots/mapg.php?Lan=E

View Form: Statlstlcs

» The logger creates a list of statistics
about our operating

= |tIs under the View menu

» The states, provinces & countries
contacted & how many times

» The number of contacts for each
mode

» How much time was spent operating

> Etc.

Operating Period: 2OP2/01/26 17 =34 = 2022 /01/26 1811

Total op time (breaks > 30 min deducted): 0:40:27
Total op time (breaks > 60 min deducted): 0:40:27

Avg Qs/Hr (breaks > 30 min deducted): 16.3

Total Contacts by Band and Mode:

Band CW Phone Dig Total
30 (0] 1130 (0] 111 100
Total (0] 1530 (0] 153L 100

Total Contacts by Section
Section Total %
AZ 1 9
EH i 9
DE 1 9
GA 1 9
NFL il 9

2 ort
Copy to Clipboard © Count » Alphabetically m

Rich Joerger
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View Form: Map

» The logger creates a map of the US and Canada with
the worked sections colored

= |tis under the View menu

Rich Joerger
WB4EHG
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Network Form: Network Status Display

Metwork Status Display 1.2 (Ctrl M)

12
Phone: I E N Eereranl . B B e

cwW: I
Digital:

70 cm 2.3 Cm 23 cr 13 cm O cm

DCARC-LAPTO

3 cm
Phone:
CW:

Digital:

L
-

This Station’s Hame: Server Name or IP: Set Msg Server to Log Port: Type message to send and press enter: Me=ssage To (blank to broadcast):
|DCARC-LAPTOP-2 | |DcaRc-LAPTOP-2 | e Host [1000

ted in networking this program for a multi op contest, DXPedition or you just want to access your log from multiple PCs simultaneously at your home or club DCARC-LAFTOP-2
station, please read on! Better yet, click the Help button to your right below, which will take you to a web page that not only includes a more recent version of gﬁg&ﬁggﬁ‘;

) ) | X
this text. but lots of graphics as welll DCARCLAPTORA
There's lots of explanation below, including how to network your PCs, enable the band status and messaging. If you are setting up for Field Day it is a MUST
READ, but in short, to network multiple PCs, simply put your log file in a location that is accessible to all the PCs you wish to netwark by clicking File > Save
As. Then, from the other PCs, click File = Open, navigate to the file and select it. Any contacts you enter should appear on all PCs in a minute or less
(depending on the refresh rate you set). That's all there is to it!

Server and clients connected

For the rest of the story, some of the emphasis is on Field Day as that environment is the ultimate test of any network, but the information below applies to

. Network Method:
networking all of my software.

(®) File Share i) TCP
There are now two methods for networking my software - File Share and TCF. File Share has been used very successfully since | first introduced the

networking versions of my software in the late 1990s with the vast majority of users. | added TCP in July, 2013 as a second networking option that should help Enable Status / Chat Functions
the few groups who encountered file share problems resulting from slow network connections and / or intermittent network connectivity. Sync Clocks

Following Field Day 2013, | received lots of great reports from the vast majority of groups who networked with File Share using my new C# rewrite (Field Day

T L oo L [

Status: Connected to: DCARC-LAPTOP-2

Rich Joerger
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Network Form: Logger Drive Share

» Our laptop implementation has the shared logger file on Laptop 2.
» The other laptops have to be configured to access this share

The folder with the database file is shared via the network with the other
laptops.

Those laptops mount the share as drive N:\
The database file is:

:\Documents\000 N3FJP Log File Share Master\LogData.mdb

To access this file, start the N3FJP WFD Logger;
Click File Menu
Click Open in the file menu
Navigate to the folder shown above and click on LogData.mdb

More details are in WB4EHG's file:

W:\My-Ham Radio\DCARC\280 - N3FJP Software\2022-01-24 Rich Joerger

Configure N3FJP for Networking.docx WB4EHG
2022/01/27



Summary

» Set your call sign and initials when you first start

» Make sure the logger Is indicating the correct band and mode

» Enter the stations call sign before you call him to check for
dups

> Work as many stations as you can

» Prioritize unworked sections but don’t let a good contact go
DO NOT TURN OFF THE COMPUER

Rich Joerger
WB4EHG
2022/01/27



